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Release Notes 
RedSpec™ 

 Version: 7.1.19 
 Release Date: July 1st, 2025 
 Expiration Date: August 1, 2026 
 

Purpose of Release 

RedSpec 7.1.19 includes an additional building code selection. 
 

Description of Changes 

Building Code Update 

The 2024 IBC ASD (US) building code selection is added.  Load Combination factors 
have been updated per Table 1 and 2.  Snow loads are to be input as strength level. 
 

 
Table 1: 2024 IBC ASD Load Combination Factors for I-Joist, Beam 

 

2024 IBC ASD (US)

I-Joist, Beam STRENGTH SERVICEABILITY

Load Combination Dead Floor Snow Roof Wind Quake LDF Dead Floor Snow Roof Wind Quake

Dead 1.0 0 0 0 0 0 0.9 1.0 0 0 0 0 0

Dead + Floor 1.0 1.0 0 0 0 0 1.0 1.0 1.0 0 0 0 0

Dead + Snow 1.0 0 0.7 0 0 0 1.15 (1) 1.0 0 0.7 0 0 0

Dead + Roof 1.0 0 0 1.0 0 0 1.25 1.0 0 0 1.0 0 0

Dead + Wind 1.0 0 0 0 0.6 0 1.6 1.0 0 0 0 0.42 0

Dead + Quake 1.0 0 0 0 0 ±0.7 1.6 0 0 0 0 0 0

Dead + Floor + Snow 1.0 0.75 0.525 0 0 0 1.15 (1) 1.0 0.75 0.525 0 0 0

Dead + Floor + Roof 1.0 0.75 0 0.75 0 0 1.25 1.0 0.75 0 0.75 0 0

Dead + Floor + Wind 1.0 0.75 0 0 0.45 0 1.6 1.0 0.75 0 0 0.315 0

Dead + Floor + Quake 1.0 0.75 0 0 0 ±0.525 1.6 0 0 0 0 0 0

Dead + Snow + Wind 1.0 0 0.525 0 0.45 0 1.6 1.0 0 0.525 0 0.315 0

Dead + Snow + Quake 1.0 0 0.1 0 0 ±0.525 1.6 0 0 0 0 0 0

Dead + Roof + Wind 1.0 0 0 0.75 0.45 0 1.6 1.0 0 0 0.75 0.315 0

Dead + Floor + Snow + Wind 1.0 0.75 0.525 0 0.45 0 1.6 1.0 0.75 0.525 0 0.315 0

Dead + Floor + Snow + Quake 1.0 0.75 0.1 0 0 ±0.525 1.6 0 0 0 0 0 0

Dead + Floor + Roof + Wind 1.0 0.75 0 0.75 0.45 0 1.6 1.0 0.75 0 0.75 0.315 0

Dead + Wind 0.6 0 0 0 0.6 0 1.6 0.6 0 0 0 0.42 0

Dead + Quake 0.6 0 0 0 0 ±0.7 1.6 0 0 0 0 0 0

 (1) LDF for combinations including snow may be set to 1.0 by the user.
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Table 2: 2024 IBC ASD Load Combination Factors for Truss 

  

2024 IBC ASD (US)

Truss STRENGTH SERVICEABILITY

Load Combination Dead Floor Snow Roof Wind Quake LDF Dead Floor Snow Roof Wind Quake

Dead 1.0 0 0 0 0 0 0.9 1.0 0 0 0 0 0

Dead + Floor 1.0 1.0 0 0 0 0 1.0 1.0 1.0 0 0 0 0

Dead + Snow 1.0 0 0.7 0 0 0 1.15 (1) 1.0 0 0.7 0 0 0

Dead + Roof 1.0 0 0 1.0 0 0 1.25 1.0 0 0 1.0 0 0

Dead + Wind 1.0 (2) 0 0 0 0.6 0 1.6 1.0 (2) 0 0 0 0.6 0

Dead + Quake 1.0 (2) 0 0 0 0 0.7 1.6 1.0 (2) 0 0 0 0 0.7

Dead + Floor + Snow 1.0 1.0 0.7 0 0 0 1.15 (1) 1.0 1.0 0.7 0 0 0

Dead + Floor + Roof 1.0 1.0 0 1.0 0 0 1.25 1.0 1.0 0 1.0 0 0

Dead + Floor + Wind 1.0 0.75 0 0 0.45 0 1.6 1.0 0.75 0 0 0.45 0

Dead + Floor + Quake 1.0 0.75 0 0 0 0.525 1.6 1.0 0.75 0 0 0 0.525

Dead + Snow + Wind 1.0 0 0.525 0 0.45 0 1.6 1.0 0 0.525 0 0.45 0

Dead + Snow + Quake 1.0 0 0.525 0 0 0.525 1.6 1.0 0 0.525 0 0 0.525

Dead + Roof + Wind 1.0 0 0 0.75 0.45 0 1.6 1.0 0 0 0.75 0.45 0

Dead + Roof + Quake 1.0 0 0 0.75 0 0.525 1.6 1.0 0 0 0.75 0 0.525

Dead + Floor + Snow + Wind 1.0 0.75 0.525 0 0.45 0 1.6 1.0 0.75 0.525 0 0.45 0

Dead + Floor + Snow + Quake 1.0 0.75 0.525 0 0 0.525 1.6 1.0 0.75 0.525 0 0 0.525

Dead + Floor + Roof + Wind 1.0 0.75 0 0.75 0.45 0 1.6 1.0 0.75 0 0.75 0.45 0

Dead + Floor + Roof + Quake 1.0 0.75 0 0.75 0 0.525 1.6 1.0 0.75 0 0.75 0 0.525

 (1) LDF for combinations including snow may be set to 1.0 by the user.

 (2) Factor is 0.6 when one or more live loads are negative.
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Release Notes (Archive) 
RedSpec™ 

 Version: 7.1.18 
 Release Date: January 9, 2025 
 Expiration Date: August 1, 2026 
 

Purpose of Release 

Roaming load for open-web trusses is implemented. 
 

Description of Changes 

Roaming Load 

Roaming load is now available for open-web trusses. It may be found on the 
Application loads tab. 
 

 
 
The roaming load accounts for one additional point load anywhere on the top or 
bottom chord of the truss. As the input is in the units of “lb” and not “plf”, the 
roaming load does not depend on spacing. It is assumed to be a dead load. 
 
Roaming load is similar to concentrated load, as it is an additional point load 
anywhere on the truss. It differs in a couple of ways, however. Whereas the 
concentrated load is prescribed by the building code, the roaming load is to be used 
at the designer’s discretion. The roaming load is not required by code, and its 
magnitude is arbitrary. Also, the concentrated load is a live load which is taken in 
combination with other dead loads only: other live loads are ignored in the 
concentrated load check. Roaming load, on the other hand, is a dead load that is 
concurrent with all other loads. 
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API Offline Error Messages 

When connection to the Simpson hanger API was interrupted for any reason, RedSpec 
reported the standard error number and description. This is revised to provide more 
explanatory language about the possible causes and remedies for the interruption.  
 

 

Other Updates and Fixes 

• Using “(Select All)” for series and locking in an 18" depth on the Design tab 
could result in an 18" Red-M truss in the Results list. The list is now limited to 
make sure the minimum depth for a Red-M truss is 20". 
 

• Although open-web truss design is limited to single trusses, it was possible, by 
entering a “2” in the plies input box and clicking elsewhere, to make it appear 
that a double truss was being designed. The false appearance carried through 
to the printout. The input box is revised to only accept “1”, regardless of 
circumstances. 
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Release Notes (Archive) 
RedSpec™ 

 Version: 7.1.17 
 Release Date: January 25, 2024 
 Expiration Date: August 1, 2026 
 

Purpose of Release 

RedSpec 7.1.17 accesses the Simpson Strong-Tie® Hanger Selector API. 
 

Description of Changes 

Simpson Strong-Tie® Hanger Selector API 

Previously, hanger selection in RedSpec was provided by a locally-installed DLL. By 
shifting hanger selection to the online Hanger Selector API, selector updates are now 
available in RedSpec instantaneously. Online access is required. 

Autosave to PDF 

Batch saving to PDF was introduced in version 7.1.13. The PDF saving procedure is 
now available as a setting in the “Options” menu. While the setting is in effect, every 
design viewed in the “Print” tab is automatically saved to PDF in the batch folder. 
The batch folder is automatically created in the same location as the current RedSpec 
project file. Refer to 7.1.13 notes for more information. 
 

 
 
 
 
 
 
 
 
Simpson Strong-Tie is a registered trademark of Simpson Strong-Tie Company Inc. 
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Release Notes (Archive) 
RedSpec™ 

 Version: 7.1.16 
 Release Date: November 17, 2023 
 Expiration Date: August 1, 2025 
 

Purpose of Release 

RedSpec 7.1.16 includes the latest Canadian hanger database. 
 

Description of Changes 

Simpson Strong-Tie® Database 

The Canadian hanger database is updated to version 2023.9.14. Database changes 
include: 
 

• Update for 2023 catalog changes. 

• Added top of wall installation for masonry. 

• Minor bug fixes. 
 
The DLL expires 9/14/2026. 

Hanger Nails 

The 0.148x2.5 nail is specified in certain Simpson hanger configurations, such as LSSR 
and WP hangers. The nail is available collated, but not in bulk or loose. For this 
reason, RedBuilt prefers to avoid its use. RedSpec is updated as follows [16bugs 2158]: 
 

• The 0.148x2.5 option for WP hangers is ignored in the hanger list. The 
0.148x1.5 and 0.162x2.5 options remain. Available capacity is not affected. 

• The LSSR hanger for Red-I45 and Red-I65 has the 0.148x2.5 option. 
o If the header width can accommodate it, the 0.148x3 nail is substituted 

with no capacity reduction. 
o If not, the SD9112 screw is substituted with no reduction. The 0.148x1.5 

substitution is also added if the 0.77 reduction factor yields sufficient 
capacity for gravity and uplift reactions. 

 
RedSpec also manipulates hanger nailing to accommodate Red-I joists with thick 
flanges, such as the Red-I90 and Red-I90HS series. An existing procedure in the 
software substitutes 0.148x1.5 nails in lieu of Strong-Grip tabs for these joists 
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because the Strong-Grip tabs do not engage the 1.75" and 2.5" flanges, respectively. A 
web stiffener requirement is added to the hanger model name to provide backing for 
the nails. As a result of this substitution procedure, in some cases the hanger list 
could have duplicates: the 0.148x1.5 nail option chosen by the Simpson hanger DLL 
and the 0.148x1.5 nail substitution option produced by RedSpec. This process is 
revised to remove duplicates from the list. In other words, when RedSpec modifies 
the nailing and stiffener properties of a hanger, it checks to see if a hanger with those 
properties is already present in the list to determine if it should be kept. 
 

Live Load Combination String 

An example of a load combination string found on the design printout is “1.0D+1.0L”. 
It indicates the factors applied to dead and live loads in the combination. For live 
load deflection, RedSpec previously printed the entire building code-specified string, 
with the understanding that the dead load in that combination was zero. This is 
updated to show only the live load factors, e.g., “1.0L”, in response to the 
preference of many users. [16bugs 1683] 
 

Uplift Deflection Check 

If uplift loads are great enough, it is possible that a design can fail in upward live load 
deflection. (Upward deflections are expresses as negative numbers.) Formerly, 
RedSpec would report the live load deflection failure under the “Pass/Fail” heading of 
the design results, while at the same time stating that the product “meets or exceeds 
the set design controls” at the top of the page. Now RedSpec will show the 
“overloaded” title in this situation. [16bugs 2081] 
 

Product Information 

Clicking the large product button at the top of the “Design” screen will now bring up 
some catalog information on Red-I commercial joists and RedBuilt open-web trusses. 
 

Other Updates and Fixes 

• Working left to right, if RedSpec failed to find a hanger option on the left end 
of the joist, it would terminate the hanger selection process, resulting in no 
available options on either end. The process is updated to continue the search 
for a hanger on the right end. [16bugs 2179] 
 

• Beam self-weight is reported in the notes section of the printout. 
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• Deflection ratios that appeared as L/99999999 or L/12345678, for example, 
indicating negligible deflection, are now displayed as L/99999 for better 
visibility on the “Results” tab. 
 

• The “Setup” menu is removed. The “Restore default products” command found 
on that menu was not used. 
 

• Load location strings such as 26' 11.875" were too long to fit in the load grid. 
The location columns in the grid are wider now to accommodate such strings. 
 

• The “Design” button is disabled after it is clicked and enabled after processing 
is complete. This is done to clarify that RedSpec is busy, which may be helpful 
during longer analysis processes such as certain open-web designs. 
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Release Notes (Archive) 
RedSpec™ 

 Version: 7.1.15 
 Release Date: August 15, 2022 
 Expiration Date: August 1, 2024 
 

Purpose of Release 

RedSpec 7.1.15 includes the latest hanger databases, an additional building code 
selection, and features for enhanced usability. 
 

Description of Changes 

Building Code Update 

The 2021 IBC ASD (US) building code selection is added. 
 

Simpson Strong-Tie® Database 

The US hanger database is updated to version 2022.7.14. US database changes 
include: 
 

• Fixed bug on LSSJ load values. 

• Fixed bug on HGU7.25x option when skewed. 

• Added LSL nailer option. 
 

Additional Header Sizes for Hangers 

The list of available header sizes is expanded to provide many more options for 
hanger supports. [16bugs 1665] 
 

Nail Description Format 

The format of hanger nail descriptions is updated. The previous format, for example, 
was like "4-10d". The new format specifies diameter and length, like "(4) 0.148x3". 
Nail size in the previous format was not clear, as a it was not specified whether the 
nail diameter was box or common, and the length was assumed, unless noted 
otherwise. The format of nailing in existing project files is automatically updated. 
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Load Location Beyond End of Member 

Upon entering a load location beyond the end of the member in previous versions of 
RedSpec, a message box appeared, advising the user of the error. The error would be 
automatically fixed if the additional load was a uniform load, as the location would be 
set to the member length after the message box was dismissed. The automatic fix did 
not occur if the load was a point or tapered load. This is updated to apply the 
automatic fix to these loads, setting the location at the end of the member. [16bugs 
964, 1667] 
 

Last-Used File 

When RedSpec is started, it attempts to open the last-used project file. If that file 
happens to be corrupted or missing, an error occurs. In the case of a missing file, 
RedSpec tries to open the Documents\RedSpec\Project1.red file instead. A corrupted 
file could cause a run-time error in other cases. RedSpec would then shut down, and 
it was not clear to the user what could be done to get out of the start-shutdown loop. 
Advisory text is added to the error messages, as well as the name and path of the file 
that is causing the issue. [16bugs 1578] 
 

New Project File Dialog 

RedSpec no longer asks the user if the specified new project file should be created. It 
proceeds with the file name entered by the user. 
 

Deflections Near Zero 

Deflections near zero were formerly reported with a blank percentage and an 
allowable deflection of zero. This is revised to show meaningful results: the 
percentage is 0%, while the allowable deflection is a non-zero number that depends 
on span length. [16bugs 1012] 
 

Member Image Exceeding Width of Form 

An image of the member is displayed on the Spans tab. A bug affected the display of 
this image in some multi-span cases. If one of the spans was very short, it was set to a 
minimum visible width, and the other spans were scaled up in proportion. The overall 
length of the member might then exceed the width of the form. This is fixed so that 
the overall length of the member is always scaled down to be fully visible in the form. 
The image is adjusted as the form is resized by the user. [16bugs 768] 
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Level Activation in Treeview 

The project treeview shows the designs in a hierarchy of project-folder-type. 
Context-sensitive right-click menus appear when a node is clicked on any level of the 
hierarchy. The feature is enhanced to enable menu commands when right-clicking on 
nodes in an inactive level of the tree, in the same branch. 
 

Tab Activation 

Tabs are enabled or disabled automatically, depending on the current design process. 
Previously, the active tab could be disabled (grayed out) when switching from one 
type to another. The behavior is revised. If the active tab on the selected design is 
disabled, the Design tab is automatically activated. As an example, the active tab 
after clicking the Design button is the Results tab. If another type is selected in the 
project tree, the Design tab becomes active, rather than the disabled Results tab. 
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Release Notes (Archive) 
RedSpec™ 

 Version: 7.1.14 
 Release Date: February 4, 2022 
 Expiration Date: July 1, 2024 
 

Purpose of Release 

RedSpec 7.1.14 is a general distribution following the internal release of 7.1.13. It 
includes an update for enhanced usability. Please refer to the 7.1.13 notes below for 
a full description of updates since 7.1.12. 

Description of Changes 

Special Characters Screened 

The new batch save command (see RedSpec 7.1.13 below) constructs PDF file names 
from the project, folder, and type names created by the user. Characters such as 
*|\/:<>?" are not allowed in Windows file names. Since these characters cause the 
batch save command to cease execution, they are now screened out of project, 
folder, and type names upon entry. 
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Release Notes (Archive) 
RedSpec™ 

 Version: 7.1.13 
 Release Date: November 18, 2021 
 Expiration Date: July 1, 2024 
 

Purpose of Release 

RedSpec 7.1.13 includes the latest hanger databases, an additional building code 
selection, and features for enhanced usability. 

Description of Changes 

2015 NBC 

The 2015 NBC load combination factors are added in version 7.1.13. The 2010 NBC 
factors remain for backward compatibility. 
 

Copy Load Button 

A "Copy" button is added to the Uniform, Point, and Tapered load tabs. It copies one 
row in the grid, the row that is the current selection. 
 

 
 

Accelerator Keys 

Accelerator keys are a standard alternative to mouse clicks. They are added to many 
interface items in this version, appearing as underlined characters in the interface 
item names. To use them to copy a uniform load, for example, as shown in the 
previous item above, click Alt+U to activate the Uniform load tab, then Alt+C to copy 
the current load. 
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Popup Menus in Project Tree 

Commands for working with projects, folders, and types are available in the "File" 
menu. In RedSpec 7.1.13, the commands may also be accessed by right-clicking on 
nodes in the project tree. The commands are enabled only if the node level is active, 
so it may be necessary to first click on the node before right-clicking. 
 

 

Batch Save to PDF 

The "Batch" tab may be accessed at any time to save selected designs to PDF. 
RedSpec loops through the designs, running each one with the current inputs, and 
saving the output files to a batch folder. 
 
To use the batch feature, select the "Batch" tab. Checkboxes appear in the project 
tree to allow selection of individual designs, folders, or the entire project. The 
predetermined batch folder location is noted on the tab. The folder is in the same 
location as the project file (.red) in use. The location cannot be changed. 
 
After the checkboxes are used to select designs, click the button to save to PDF. The 
looping process takes some time. When it is finished, the batch folder will have the 
same folder structure and design content shown in the project tree. Each design is 
saved to a separate file with a name in the Project_Folder_Type.pdf format. 
 
The PDF files, once created, remain in their folders. They are overwritten if the batch 
procedure is used again. RedSpec does not delete the files or folders. When designs or 
folders are deleted from the project tree, the PDF files remain until they are 
manually deleted by the user. 
 
Note that batch saving is prevented if an existing PDF file is in use (open in another 
program). RedSpec will skip other designs in the same folder if it encounters one in 
use. 

Simpson Strong-Tie® Database 

The US hanger database is updated to 2021.10.13. The Canadian hanger database is 
updated to 2021.9.23. US database changes include: 
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• THA hangers: add MAX nailing options for top flange installations. 

• Add TNT masonry screws for concrete and masonry connectors. 

• B and WP series hangers: multiple load updates for various headers and nailers. 

• THA series: multiple load updates for both face mount and top mount. 

• Add LSSR 2x hangers. 

• Add BA210-2. 

• Update HHUS, HU412, HGUS, BA, HB, WMU hanger loads. 

• Update HU masonry hanger loads. 

• Update LUS210, HU212, WMU dimensions. 

• Update U hanger skewed loads. 
 
The Canadian changes include: 
 

• Add HUS1.81/10 for SPF/LVL using N10 nails. 

• Update hanger dimensions. 

• Update ICI index. 
 

Other Updates and Fixes 

• A 5% reduction in truss chord allowable stresses is applied when spacing is 48" 
o.c. The adjustment ensures a feasible, geometrically desirable truss design in 
accordance with current RedBuilt Design Center practice. 
 

• There are several minor interface revisions to fonts, colors, and input 
placement. 
 

• The depth-to-width ratio check is revised so an error is not raised when 
switching a member from 1.75"x18" RedLam LVL to a truss. [16bugs 1582, 1958] 
 

• The HasChanged method sometimes prevented an I-joist with holes from 
proceeding to the Results screen. This is fixed by rounding the hole location to 
four decimal digits. [16bugs 1726] 
 

• Location precision is revised to prevent spans from adding up to 29'-12.0", for 
example. This is corrected to display 30'-0". [16bugs 1710] 
 

• Top-flange options in the hanger screen now become invisible when the face-
mount filter is selected. Previously, they were disabled but visible. 
 

• When calculating required bearing length of I-joists, check for the condition 
where no web stiffener reaction values exist, such as the 9.5" Red-I45. 
Previously, this could result in an erroneous "overload" message when the 
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reaction was equal to the allowable reaction, within rounding. [16bugs 1324] 
 

• The concealed hanger option is removed from the hanger style filter dropdown. 
The filter yields no results. Concealed hangers may be found within the list of 
face-mount hangers. 
 

• If the span deflection ratio was zero, "2L/0" was displayed on the printout for 
upward deflections on overhangs. This is revised to display "2L/999+". On the 
"Results" tab, it is displayed as "2L/99999". [16bugs 959] 
 

• Hangers with a Strong Grip seat accommodate flanges up to 1.5" thick. Deeper 
flanges are best attached with nails into web stiffeners. The nails and 
stiffeners provide uplift capacity and prevent squeaking in floor systems with 
deep-flange joists. Accordingly, IUS and ITS hangers supporting Red-I90H and 
Red-I90HS joists employ joist nails and web stiffeners in lieu of the Strong Grip 
attachment. [16bugs 1465] 
 

• Previously, joists with any amount of slope or skew were required to have web 
stiffeners at hanger bearings. This now defaults to the hanger selector's 
requirements. Up to certain limits, joists may be skewed or sloped in 
unmodified hangers without web stiffeners, though allowable reactions may be 
reduced in some cases. The reductions are incorporated into the hanger 
selector. 
 

• Hanger slope and skew are not always apparent on the printout. Hangers such 
as the LSSU are fit to the joist during installation, so angle modifications (e.g., 
SLU5, SKL5) are not part of the model name. To assist in design review, the 
user's selection of slope and skew are added to the print description of the 
hanger. Slope and skew appear below the hanger model name. [16bugs 1320] 
 

                        
 

• A bug prevented the load diagram on the "Loads" tab from being shown on any 
rectangular section without concentrated load. The diagram now appears for 
beams with any selection of application loads. 
 

• Previous versions required Adobe Reader for viewing the EULA. RedSpec now 
opens the PDF in the viewer designated as the default program on the host 
computer. 

 
 

Simpson Strong-Tie is a registered trademark of Simpson Strong-Tie Company Inc. 
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Release Notes (Archive) 
RedSpec™ 

 Version: 7.1.12 
 Release Date: June 2, 2020 
 Expiration Date: July 30, 2023 
 

Purpose of Release 

The version is an annual update that includes the latest hanger databases.  
 

Description of Changes 

Simpson Strong-Tie® Database 

The US hanger database is updated to version v2020.4.16. The Canadian hanger 
database is now version v2020.4.22. US database changes include: 
 

• Expand HWP specials ability. 

• Add EGQ glulam header options. 

• Update THA422 face-mount load. 

• Update SD screw values in double-shear hangers. 

• Update HWPH offset top flange factors. 

• Limit BA hangers top flange slope options to no less than 14" in height. 

• Limit top flange open option to no less than 9.25" in height. 

• Update WMU joist nails quantity. 

• Update HB joist nail lengths on narrow hangers. 

• Update BA specials uplift load. 

• Update HWPH 4x SPF load. 

• Update LSSR joist nail quantity when skewed. 

• Correct heights of WP312, HB610, HB612, HB614. 

• Correct ITS joist nail quantity. 

• Add description for 10dx2.5" nail. 
 
Canadian database changes include: 
 

• Update sizes for BA, WP, HWP HWPN, EGQ, HGU, HHGU. 

• Add DGF, DGBF, DGHF, LSSR, H1.81Z. 

• Remove B, LBV, W, GLT, GLTV, HW, HWU, HHG, LSU. 
 

Simpson Strong-Tie is a registered trademark of Simpson Strong-Tie Company Inc. 
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Release Notes (Archive) 
RedSpec™ 

 Version: 7.1.11 
 Release Date: March 23, 2020 
 Expiration Date: March 31, 2022 
 

Purpose of Release 

Product acceptance references are added to notes on printouts. This version is 
released to Design Centers for inclusion in shop drawing packages. No other changes 
are included.  
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Release Notes (Archive) 
RedSpec™ 

 Version: 7.1.10 
 Release Date: May 17, 2019 
 Expiration Date: March 31, 2022 

 

Purpose of Release 

The version is an annual update that includes the latest hanger databases.  
 

Description of Changes 

Building Code Update 

The 2018 IBC ASD (US) building code selection is added. 

Simpson Strong-Tie® Database 

The US hanger database is updated to v2019.1.1. The Canadian hanger database 
remains v2018.1.1. US database changes include: 
 

• Add new WP series hangers to replace various discontinued products. 

• Add new EGQ series hangers in glulam widths. 

• Update IUS, HTU, SUR, and LRU series hangers to allow short nails on 4x 
headers. 

• Remove GB, HGB, HHB, GLT, GLTV, HGUQ, HW, HWI, HWU, LSSU, LSSUI, 
LSSUH, W, WI, WNP, WPI, WNPU, and WPU. 
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Release Notes (Archive) 
RedSpec™ 

 Version: 7.1.9 
 Release Date: October 1, 2018 
 Expiration Date: July 1, 2021 

 

Purpose of Release 

The version includes several enhancements and bug fixes, as well as the latest hanger 
databases. Version 7.1.9 also is the general release of the changes included in version 
7.1.8. Please see the release notes for 7.1.8 below for more information. 
 

Description of Changes 

Allowable Hole Shear 

Allowable hole shear in Red-I™ joists is in accordance with design equations found in 
section 4.6.1 of ICC-ES Evaluation Report for RedBuilt™ Open-Web Trusses, ESR-2994. 
For simplicity, equations in the report for duct holes, defined as rectangular holes the 
full depth of the web, are consolidated for similar series. For example, the same 
equations are used for Red-I65™ and Red-I90™ joists. RedSpec 7.1.9 now includes the 
consolidated duct hole analysis in accordance with ESR-2994. Results are more 
conservative where hole width exceeds hole height and for consolidated series. 

Simpson Strong-Tie® Database 

The US hanger database is updated to v2018.1.1. The Canadian hanger database is 
updated to v2018.1.1. Also, new I-joist and glulam header sizes are added, while 2x14 
and 2x16 nailers are removed. Database changes include: 
 

• US add: DG, DGB, DGH drywall hangers. 

• US add: wall with drywall “at stud” allowable loads. 

• US update: limits of concealed flange hangers skewed over 45°. 

• CAN add: HWP and HWPH top-flange purlin hangers. 

• CAN update: matches C-C-CAN2018 catalogue. 

• CAN remove: WM masonry hangers (replace with WMU series). 
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Bug Fixes 

1. On designs with positive load and negative load that add up to zero, the load 
diagram drawing routine placed a vertical line on the printout to the top of the 
page. A similar issue occurred if a negative load extended to the right of a 
positive tapered load. These cases are handled to prevent the vertical line. 

2. In certain cases on new designs that are switched from the default floor joist to 
a default roof joist, the duration factor remained at 100% (US IBC) until the 
application loading was selected or the project file closed and opened to 
restore the duration factor to 125%. The duration factor is now set correctly in 
these circumstances. 

3. Various errors associated with the project pane are resolved. These include the 
“key is not unique in collection” message, multiple check marks indicating the 
active design, new joist designs that switch to beam designs, and run-time 
errors when deleting a type from the project tree. 

4. Deflection under tapered loading was affected slightly by updates in the 7.1.6 
version. Improved analysis provides more accurate results with or without 
simultaneous point loads and for tapered load on right end vs. tapered load on 
left end. 
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Release Notes (Archive) 
RedSpec™ 

 Version: 7.1.8 
 Release Date: December 21, 2017 
 Expiration Date: July 1, 2020 

 

Purpose of Release 

The version is compatible with more-restrictive user permissions, and graphic 
performance is improved for Windows® 10 systems. The release is limited. 
 

Description of Changes 

Paths of Installed Files 

Program files that must be read/write are now installed in the 
C:\ProgramData\RedBuilt\RedSpec folder rather than the program files folder. The 
purpose is to resolve issues for users with restricted permissions in the program files 
folder. 

Startup File 

Graphic issues in Windows® 10 with high DPI scaling were addressed in version 7.1.6 
by setting application properties. The new method relies on a startup file. The former 
RedSpec.exe application is broken into two files, RedSpec.exe and 
RedSpecStartup.exe, to resolve the issues with scaling. Desktop icons for initiating 
RedSpec are now directed to the RedSpecStartup.exe. 
 

 

 

 

 

 

 

 

 

 
Windows is a registered trademark of Microsoft Corporation in the United States. 
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Release Notes (Archive) 
RedSpec™ 

 Version: 7.1.6 
 Release Date: July 10, 2017 
  July 25, 2017 
 Expiration Date: July 1, 2020 

 

Purpose of Release 

The release of version 7.1.6 coincides with publication of the revised ESR-1774 and 
the release of RedOpenWeb 5.0.24. Version 7.1.6 also is the external release of the 
changes included in version 7.1.5. Please see the release notes for 7.1.5 below for 
more information. Version 7.1.6 includes additional improvements noted here. 
 

Description of Changes 

New Web Design Values for Open-Web 

The ICC-ES Evaluation Report for RedBuilt™ Open-Web Trusses, ESR-1774, has been 
revised and published May 2017. The evaluation scope was expanded to include 2015 
International Building Code® and 2015 International Residential Code®. In accordance 
with these codes, the table of “Allowable Load on Web Members” is updated with 
new values for tension and compression at small and large pins. 
 
Users are advised that this version of RedSpec (7.1.6) is a mandatory update. 
RedBuilt open-web trusses are designed and fabricated in accordance with ESR-1774. 
It is important that specifications of open-web trusses are done with RedSpec 7.1.6 to 
ensure feasibility in manufacturing. 
 
Truss component costs are updated as well. Costs are reflected in the relative price 
ranking of truss designs. Accurate costs are essential in finding the most economical 
design for the given span and loads. 

Bug Fixes 

1. A bug in version 7.1.5 resulted in partition load appearing on the output of roof 
joist designs if a floor design was switched to roof and designed immediately 
without saving. The partition load did not affect the design. Its erroneous 
appearance on the output is fixed in this version. 

2. A Canadian joist design stated that the member was overloaded, even though 
all design criteria passed. The deflection check correctly evaluated the 
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1.0D+0.9S load combination, but a secondary check for overload incorrectly 
factored the loads as 1.0D+1.0S. The secondary check is fixed in this version so 
the design is not labeled as overloaded. 

3. Previously the complete load diagram, with all application and additional 
loads, did not appear in the load screen until the member was designed. Now 
the complete load diagram appears at all times. 

4. Truss designs that failed in deflection only did not previously state the design 
control percentage. Now the printout header says, “Design control due to 
deflection,” with a percentage. 

5. New fastener codes for powder-actuated fasteners appear in the hanger 
screen, e.g., PDPAT-62KP. 

6. The default product list is generated without program restart on installs and 
updates. 

7. Display settings of 150% or greater on DPI scaling formerly raised run-time error 
380, with no further information for the user. The error is handled now, and 
the high DPI setting for the RedSpec application is disabled to ensure optimum 
user interface performance. 7/25/2017: The “scaling performed by” 
compatibility setting is set to “System (Enhanced)” at installation for 
applicable Windows® versions. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Windows is a registered trademark of Microsoft Corporation in the United States. 

Simpson Strong-Tie is a registered trademark of Simpson Strong-Tie Company Inc. 



  

RedBuilt™, RedSpec™, RedOpenWeb™, Red-I™, Red-I45™, Red-I45L™, Red-I58™, Red-I65™, Red-I65T™, Red-I90™, 
Red-I90H™, Red-I90HS™, Red-L™, Red-LT™, Red-W™, Red-S™, Red-M™, Red-H™, RedLam™, FloorChoice™ are 
trademarks of RedBuilt LLC, Boise ID, USA. Copyright © RedBuilt LLC. All rights reserved. 

 25 of 74 

Release Notes (Archive) 
RedSpec™ 

 Version: 7.1.5 
 Release Date: April 13, 2017 
 Expiration Date: July 1, 2019 

 

Purpose of Release 

“Save As…” functionality is added, along with enhanced guidance on certain design 
limitations. The release is internal to RedBuilt™ Design Centers. 
 

Description of Changes 

“Save As…” Command 

A “Save As…” command is added to the File menu. This enables the user to commit 
unsaved changes to a new project file without affecting the original project file. Also, 
an existing project file may be copied without having to use Windows® Explorer. 
 
Previous versions of RedSpec read only one member type at a time, so it was not 
feasible to write an entire project to a new source file. The new RedSpec retains each 
member type in memory and thus is able to save changes back to the original file or 
to a new project file with the “Save As…” command. 
 
Since previous versions could read only one type at a time, it was necessary to save 
changes when switching from one design to another. Closing the file without saving 
changes preserved at most one design in its original state. The new RedSpec allows 
the user to make changes to many designs, and still retain the original project file by 
closing without saving changes. This also eliminates messages that formerly appeared 
when switching between types, as previous versions of RedSpec always asked the user 
if changes should be saved when unloading one type and loading another. 
 

Guidance on Open-Web Design Limitations 

The RedSpec open-web engine attempts to create a real truss design meeting the 
user’s span and load requirements. In the process, web sizes and angles are selected, 
chord grade is selected, and pins are located in the chords to satisfy RedBuilt 
manufacturing requirements. This ensures that the resulting truss design is acceptable 
to the designer and feasible for RedBuilt manufacturing. 
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At times RedSpec identifies an issue with the design that calls for further attention 
from the designer. One example is special hardware. A substantial point load applied 
directly to a truss chord may lead to a pin-bearing overstress, in which case it is 
necessary to attach special hardware, such as a header clip, to transfer the load 
directly to a pin. The special hardware requirement appears on the “Results” tab and 
the printout in RedSpec, alerting the user with a text message in the “Notes” section. 
 
If the note is overlooked, the issue may arise later and cause difficulties in making a 
production design. It is imperative that such issues be resolved early. 
 
This version of RedSpec emphasizes and prioritizes these design limitations. In 
addition to the notes, the output now states that the truss design is overloaded, 
describes the reason, and advises the user to contact RedBuilt for design assistance. 
 
Design limitations requiring further action to determine feasibility: 
 

• Bearing Clip Overload: Load must be reduced. 

• Special Hardware Required: Header clips or inverted bearing clips are required 
to support a heavy point load. The clips must be precisely located at a truss pin 
by RedBuilt engineering. This is not always feasible; for example, a clip and pin 
may not be placed very close to the bearing clip. 

• Geometric Constraint: Manufacturing limitations pertaining to web angles, 
panel lengths, chord cutoffs, etc. require the assistance of RedBuilt 
engineering. 

 

On-Center Spacing Limit 

RedBuilt engineering guidelines treat widely spaced members with additional scrutiny. 
Spacing beyond 48" may affect permanent and temporary bracing systems, installation 
method, chord cap or filler requirements, joist hanger selection, and so on. 
Consequently, the custom spacing input for trusses and I-joists is now limited to 48". 
The user is advised via popup message to contact RedBuilt for design assistance for 
wider spacing. The spacing limitation does not apply to rectangular sections. 
 
Existing design files with spacing greater than 48" may be run in RedSpec 7.1.5, but if 
the custom spacing is edited, the spacing limit is imposed. 
 

Simpson Strong-Tie® Database 

The US hanger database is updated to v2017.1.3. The Canadian hanger database is 
updated to v2016.1.1. Changes to the US version include: 
 

• Added UA/HUA, HWP/HWPH, LSSJ hangers. 
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• Added skew option to DHU hangers. 

• Added uplift to WMU hangers. 

• Added steel header option for B, BA, ITS. 
 

Bug Fixes 

1. A note stating “Cannot mix snow and roof load durations” erroneously 
appeared in some circumstances when attempting to design a roof member. 
The user could workaround by reselecting the application load and proceeding 
as usual. Mixes of snow and roof loads still are not allowed, but the note only 
appears when this rule is violated. 

2. A run-time error at startup caused by a corrupt design file is fixed. If the last-
used file indicated in the registry is corrupt, RedSpec will open to a blank 
screen now. 

3. A roof design with application loading of “Snow(100%)” was run with a duration 
factor of 115%, and “Snow(115%)” was displayed on the output. The 
workaround was to reselect the application loading. This bug is fixed. 
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Release Notes (Archive) 
RedSpec™ 

 Version: 7.1.4 
 Release Date: April 11, 2016 
 Expiration Date: July 1, 2018 

 

Purpose of Release 

The Simpson Strong-Tie® hanger databases are updated. 
 

Description of Changes 

Simpson Strong-Tie® Databases 

Both the US and Canadian hanger databases are updated. Revisions include: 
 

US (v2016.1.1) 
• Add 4x nailers in Hem Fir. 

• Add new Hem Fir header sizes. 

• Allow HGLTV on multi-ply LVL headers. 

• Update B series specials allowable loads. 
 
Canada (v2015.1.1) 

• Add HHSUQ SCL hanger. 

• Update factored resistances to match C-C-CAN2015 catalogue. 

Bug Fixes 

1. Some RedSpec users encountered run-time errors while using the New or Open 
commands after updating to version 7.1.3. The bug occurred if an existing 
project file was already open before executing the command. Some affected 
users were able to work around by using the New or Open buttons rather than 
the menu commands, or by closing the existing file first. The bug is fixed in this 
version.  
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Release Notes (Archive) 
RedSpec™ 

 Version: 7.1.3 
 Release Date: March 10, 2016 
 Expiration Date: July 1, 2018 

 

Purpose of Release 

The hole shear analysis for I-joists is refined to take advantage of program changes 
introduced in version 7.1.0. Other updates and usability improvements are included. 
 

Description of Changes 

I-Joist Shear at Holes with Concentrated Load 

The analysis of shear at hole locations on I-joists is updated. In previous versions, 
legacy program code employed a simplified, conservative method for determining 
shear with concentrated load. By this method critical shear due to partial-span live 
load was found, then the concentrated live load was added. The result was 
conservative since the building codes (for example, 2015 IBC Section 1607.4) stipulate 
that designs are to consider uniformly distributed and concentrated live loads as 
separate rather than concurrent cases. 
 
Beginning with version 7.1.0 (see archived release notes below) the partial-span and 
concentrated live load cases were run as separate analyses. The simplified method of 
adding concentrated load to the partial-span load case was applied inconsistently due 
to a bug in the program code. If the hole location calculated in feet was a repeating 
decimal, the partial-span and concentrated live loads were considered as separate 
load cases. For example, if the hole shear location was 6ʹ-4", or the repeating decimal 
6.3333… feet, the two code-prescribed load cases were considered separately. The 
concentrated load would be added to the partial-span live load shear, on the other 
hand, if the location was a terminating decimal such as 6.5 feet. 
 
In the new version the repeating-decimal bug is fixed so the partial-span and 
concentrated live load cases are always separate. Compared to the previous version 
the design/allowable percentages on shear at holes will be reduced on many designs. 
A new concentrated load configuration is added in version 7.1.3 to generate worst-
case shear at hole locations, however, which can result in increased design/allowable 
percentages in some cases. The new configuration places the concentrated load 
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directly at the hole shear location. This is in addition to the previous concentrated 
load locations at each end and in the middle of each span. 
 
A summary of the live load configurations for a single-span I-joist with one hole is 
shown below. For the sake of simplicity loads depicted are uniform live and 
concentrated live only. Dead load, which is included in all analyses, is not shown. The 
first four patterns are run on any floor joist with concentrated load. The last three 
are run if a hole is present. 
 

Full-span uniform live 

 
 

Concentrated live, left 

 
 

Concentrated live, mid 

 
 

Concentrated live, right 

 
 

Partial-span uniform live, left 

 
 

Partial-span uniform live, right 

 
 

Concentrated live, at hole 
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The magnitude of the concentrated live load implied in this discussion is derived by 
the same rules used in previous versions: if the joist spacing is 24" or less, half the 
input load is used, assuming load distribution to adjacent members; for wider spacing 
the full input load is used. 
 
For multi-span joists the partial-span configurations shown are applied to the span 
with the hole. Other spans are loaded with dead load only. 
 
A round hole is shown in the figures above. Load locations are indexed from the 
center of round holes. This represents another refinement in the hole shear analysis, 
as previous versions of RedSpec indexed left and right edges of round holes, a 
conservative but simpler method. For square and rectangular holes, load locations 
continue to be referenced from both left and right edges, as required for those 
shapes. 
 
On the Print tab, holes are identified in the hole shear results as “H1” and “H2” 
rather than “#1” and “#2,” etc. The hole names match the list of holes shown in the 
lower part of the page, indicating the order in which the holes are input by the user, 
not the order of the hole locations from left to right. 
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Other Features, Updates 

1. The 2015 IBC ASD (US) building code selection is added. 

2. Seismic loads on open-web truss designs are now factored by 0.7 in IBC ASD 
load combinations, in accordance with ASCE 7. This ultimate-to-ASD conversion 
factor leads to consistent results, comparing truss designs with I-joist/beam 
designs, as the latter have always incorporated this factor. Input assumptions 
regarding ultimate vs. ASD (or strength vs. service) are displayed on the load 
input screens, as described in the 7.1.1 version notes below. 

3. The input grids for additional uniform, point, and tapered loads are sized to 
make use of available space on the load input tabs. Also, the sizes are no 
longer static: as the window is enlarged by the user, the load grid expands as 
well. These changes increase the number of loads that may be viewed in the 
grids without having to scroll. 

4. The US Simpson hanger database is updated. 

Bug Fixes 

1. Some RedSpec users running Windows® 8.1 or Windows® 10 operating systems 
have experienced a bug in the Project treeview control. When clicking on the 
design Type to select it, the icons and text in the treeview would disappear, 
making it impossible to add more designs to the project folder. The bug is fixed 
in this version. 

2. On I-joist floor designs with multiple spans and multiple holes, if the design 
was overstressed due to shear at the hole, the non-hole shear in some cases 
was displayed as zero. This is fixed to report the actual critical shear. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Windows is a registered trademark of Microsoft Corporation in the United States.
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Release Notes (Archive) 
RedSpec™ 

 Version: 7.1.2 
 Release Date: October 28, 2015 
 Expiration Date: July 1, 2017 

 

Purpose of Release 

Version 7.1.2 includes two bug fixes. 
 

Description of Changes 

Bug Fixes 

1. The hanger selection controls in the previous version were missing header sizes 
for the following header types: 
 
  Sawn HF 
  I Joist DF (1.375) 

    Wall DF, Sheathed Flush 
    Wall DF, Sheathed Gap 
    Wall DF, Drywall Flush 
    Wall DF, Drywall Gap 
    Wall SPF, Sheathed Flush 
    Wall SPF, Sheathed Gap 
    Wall SPF, Drywall Flush 
    Wall SPF, Drywall Gap 

 
The header sizes are restored. 
 

2. When changing the selected building code on a beam design from 2009 IBC to 
2012 IBC (or vice versa), the beam series and depths were not available in the 
Design screen unless the project file was closed and re-opened. This is fixed so 
RedLam LVL, glulam, and sawn lumber beams may be selected for design after 
a change of US building code. 
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Release Notes (Archive) 
RedSpec™ 

 Version: 7.1.1 
 Release Date: September 30, 2015 
 Expiration Date: July 1, 2017 

 

Purpose of Release 

Version 7.1.1 is the external release of the changes included in version 7.1.0. Please 
see the release notes for 7.1.0 below for more information. Version 7.1.1 includes 
additional improvements noted here. 
 

Description of Changes 

Features 

1. The user sets deflection limits in the Serviceability tab. Previously these limits 
would reset if the member type (joist, beam, truss) was changed. Now the 
limits are retained. (The limits still reset to default values if the member 
application is changed between floor and roof.) 

2. To alleviate the confusion on entering wind and seismic loads for IBC design, a 
label on the load input tabs indicates whether RedSpec assumes service-level 
or strength-level inputs for W and E. These assumptions reflect the differences 
between 2012 IBC and 2009 IBC ASD load combination factors. 

3. The Red-LT truss series is removed from the Design tab selections, as it is no 
longer available. 

4. The 1.5x20 and 1.5x20 DBL ledger options are added to the header list in the 
Hangers tab. 

Bug Fixes 

1. In version 7.1.0 renaming a folder or changing the building code to 2012 IBC 
could cause a design error or resetting of the building code in some 
circumstances. To work around, the user could reselect the load occupancy and 
redesign the member. This is fixed so the building code selection is retained. 

2. In version 7.1.0 the joist or beam optimization feature could produce erroneous 
results in some circumstances. This is fixed to ensure each joist or beam in the 
Results list is a valid design. 

3. The FloorChoice rating is slightly reduced when a joist span is supported on one 
or both ends by a beam, which is considered more flexible than a wall or 
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ledger. The analysis now applies the flexible-support reduction to truss designs 
as well. 

4. If the residential joist button was clicked in the Member tab, followed by 
clicking the beam button, the list boxes on the Design tab would be empty. No 
product could be selected or design. The workaround was to select any other 
button before clicking the beam button. This is fixed. 

5. Beginning with a project file of truss designs and changing them one at a time 
to joist designs, the second and subsequent joist designs had no available 
hanger selections. The workaround was to reselect the header in the Hangers 
tab. This is fixed so the hanger results list is always available. 

6. A 5" diameter hole in a floor joist at 10" from the support would generate a 
design error message and prevent results. The workaround was to change the 
diameter to 4.999" or less or move the hole to 10.001" or more. This has been 
fixed to allow the hole location. Other hole designs adhering to the “two 
diameters from the support” rule were not affected by this bug. 

7. Span bending moments are shown in the Detailed Report. For certain floor 
designs where the bending moment due to concentrated live load was negative 
throughout the span, a zero was displayed. This is changed so the span moment 
is blank. The design in this case is governed by negative moment at the 
adjacent supports. 

8. The “Display Load Cases” option in version 7.1.0 would produce an error 
message and prevent the display of design results. This is fixed. 

9. The number of displayed load cases is reduced to show only the strength 
combinations and only the “All Spans” pattern for dead load. 
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Release Notes (Archive) 
RedSpec™ 

 Version: 7.1.0 
 Release Date: June 2, 2015 
 Expiration Date: July 1, 2016 

 

Purpose of Release 

Load combination factor tables for Red-I™ joists and rectangular-section beams are 
introduced to RedSpec in this version. The release is internal to RedBuilt™ Design 
Centers. The hanger selection database is updated as well. 
 

Description of Changes 

Load Combination Factors 

Building codes specify factored combinations of loads to be considered for strength 
and serviceability design of structural members. Previous versions of RedSpec™ have 
taken these into consideration in the design of open-web trusses. The design of 
I-joists and rectangular sections, however, has been restricted to a few basic 
combinations. For example, design under the “IBC ASD” code selection was executed 
with a factor of 1.0 on all input loads. 
 
Version 7.1.0 introduces expanded tables of load combination factors to RedSpec for 
the design of Red-I™ joists, RedLam™ LVL beams, glulam beams, and sawn lumber. 
Available factor tables include: 
 

• 2012 IBC ASD (US) 

• 2009 IBC ASD (US) 

• 2010 NBC LSD (CAN) 
 
The tables of factors for strength and serviceability are extensive. The user is 
referred to the RedSpec Help topic on “Load Combination Factors” for a complete 
list. 
 
Two design examples demonstrate the effects of this update. The first example 
includes floor and roof loads using 2012 IBC ASD. The joist carries typical residential 
floor loads as well as a wall that supports a roof above. Span and loads are as shown 
below: 
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In previous versions a 16" Red-I45™ joist was sufficient, with a maximum design 
percentage of 95% due to positive moment: 
 

 
 
In version 7.1.0 a shallower joist is sufficient. Under the heading “Combination” the 
load combination factors are displayed. In this case the floor and snow loads are 
factored by 0.75. The design takes advantage of the 25% reduction of simultaneous 
transient loads allowed by the building code, obtaining a 2" reduction in depth while 
relieving the web stiffener requirement on the right end of the joist. 
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Another example demonstrates an uplift design method. Again, the building code is 
2012 IBC ASD (the method is similar in the other codes). In previous versions of 
RedSpec it was necessary to design the joist twice: once for gravity loads and a 
second time for uplift loads. The user was responsible for factoring uplift loads as 
required by the building code to account for reduced dead load. The span and loads 
for this version 7.1.0 demonstration are shown: 
 

 
 
Note that the wind load is applied as an “Adds To” load rather than “Replace,” using 
full design wind pressure rather than net uplift. As prescribed by the building code, 
RedSpec considers 1.0D+1.0Lr and 0.6D+0.6W, among other load combinations, finding 
critical gravity and net uplift combinations. The results are apparent on the Hanger 
tab of RedSpec. The “Load Down” and “Load Up” are shown in the right side of the 
figure below: 
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The selected hanger is sufficient for both load directions, so a second design is 
unnecessary. The uplift combination appears again on the Print tab in the design for 
negative moment: 
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Clicking on the “Show Detailed Report” button on the Print tab expands the output. 
The additional pages provide reference design values for the member, as well as the 
reactions, shears, moments, and deflections computed for each load combination. 
When the “Show Detailed Report” button is clicked, the caption toggles to “Hide 
Detailed Report” so the output can be condensed again. 
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Other Changes 

1. Previous versions of RedSpec ran an additional shear check on continuous-span 
joists and beams, where each span was analyzed as if the joist were cut at 
intermediate supports. The difference in shear is minimal, so the “simple span” 
shear condition is no longer run. 

 

Bug Fixes 

1. The correct load duration factor is shown on dead-load-dominated reactions 
under the LSD design methodology. The factor previously output as 100 may 
now be a number between 65 and 100. The change has no effect on the 
magnitude of the reported reactions, as these are unfactored. 

2. Negative reactions due to concentrated load on continuous-span members are 
now consistently reported in the “Supports” section of the output. 

 

Hanger Database 

The latest US Simpson hanger database includes these updates: 
 

• BA: Added sizes. 

• EGQ: Now skewable. 

• GLTV: Updated LVL and LSL loads. 

• ITS: Added optional uplift loads. 

• JBA, LBAZ: Added sawn lumber hangers. 

• LRU: Allows slope to 49 degrees. Updated uplift loads and installed cost. 

• MIT: Allowed on 3x ledger. 

• PF: Updated loads. 

• SUR/L: Allows skew to 50 degrees.  

• W: On skewed floor members has “Type B” nomenclature. 

• Adjusted minimum slope and skew limits for specials on various hangers. 
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Release Notes (Archive) 
RedSpec™ 

 Version: 7.0.21 
 Release Date: January 12, 2015 
 Expiration Date: July 1, 2016 

 

Purpose of Release 

The open-web cost database is updated. 
 

Description of Changes 

Open-Web Cost Database 

When multiple truss series, depths, or spacings are selected in the Design screen, 
RedSpec™ may find several potential designs meeting these criteria. The designs are 
listed in the Results screen, ranked from lowest to highest cost. The database update 
ensures that the relative cost sorting reflects current RedBuilt™ open-web costs, 
effective this date. 
 
The user is advised to consult with the local RedBuilt™ technical representative for 
product pricing.
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Release Notes (Archive) 
RedSpec™ 

 Version: 7.0.20 
 Release Date: November 19, 2014 
 Expiration Date: July 1, 2016 

 

Purpose of Release 

This version introduces the residential/multi-family Red-I™ joists. It also includes the 
latest hanger databases and a few minor fixes. 
 

Description of Changes 

Residential/Multi-Family Red-I™ Joists 

The Red-I45L™ and Red-I58™ are available for the residential/multi-family market. 
Consult with your local RedBuilt™ technical representative to confirm which type of 
joist is best for your project. 
 
The joist family may be selected on the Member tab. The analysis is identical to the 
commercial Red-I™ joist analysis. The joists may be designed as floor or roof 
members. 
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Hanger Database 

The latest US Simpson hanger database includes these updates: 
 

• Added new DU, DHU, DHUTF series drywall hangers. 

• Expanded selection of hangers rated for use with SD9 and SD10 screws. 

• Adjusted skew limits on HUC concealed flange hangers. 

• Added sheathed stud wall support types, including wood structural panel 
sheathing or drywall, installed flush or dropped (i.e., with gap).  

• Added “Sawn HF” header type. 

• Extended expiration date. 
 
The Canadian database expiration date is extended. 
 

Bug Fixes 

1. In some cases, in previous versions the text of the header row could be altered 
by deleting the last remaining load in any of the load subtabs. This had no 
effect on the analysis. Header text would be restored by opening and closing 
the program. This is fixed so the header row text is no longer affected. 

2. Allowable moment depends on lateral support, which the user sets on the 
“Spans” tab. Occasionally it has been found that the lateral restraint is set to 
“At Supports,” which may reduce allowable moment significantly. It is 
suspected that the restraint input has been changed inadvertently by the user. 
These inputs are removed from the tab stop index so they do not receive focus 
without direct selection by the user. 

3. The “Application” loads subtab has a dropdown list for typical occupancy loads. 
Users may click and scroll to choose occupancy, or they may enter a keyboard 
character to select the first load starting with that character. The latter action 
caused a run-time error in the previous version. This is fixed. 

4. Web links in the Help topics are directed to the new locations in 
www.redbuilt.com. 
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Release Notes (Archive) 
RedSpec™ 

 Version: 7.0.18 
 Release Date: December 5, 2013 
 Expiration Date: July 1, 2015 

 

Purpose of Release 

Version 7.0.18 is the external release of the changes included in version 7.0.17. 
Please see the release notes for 7.0.17 below for more information. 
 

Description of Changes 

Interface Revisions 

1. The CVC control for Canadian floors no longer fails Red-I™ joist designs. The 
vibration note is presented, with the “meets” or “does not meet” cautionary 
text, but the design does not fail if the vibration control is greater than 100%. 

 

Bug Fixes 

1. The floor performance rating is the same regardless of whether a joist is 
designed by optimization (i.e., “(Select All)” for series, depth, or spacing) or 
by fully defined series, depth, and spacing. Designs in version 7.0.17 could have 
discrepancies based on method. 

2. The floor performance rating no longer appears on the print preview if the 
FloorChoice™ checkbox is not checked on the Serviceability tab. The rating 
would be displayed for open-web floor designs regardless of the checkbox 
status in version 7.0.17. 
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Release Notes (Archive) 
RedSpec™ 

 Version: 7.0.17 
 Release Date: November 14, 2013 
 Expiration Date: July 1, 2015 

 

Purpose of Release 

Version 7.0.17 introduces FloorChoice™ rating for open-web trusses. It includes other 
minor interface changes. This is an internal release for usability testing prior to 
external release. 
 

Description of Changes 

FloorChoice™ Update 

The RedBuilt™ method for evaluating floor performance has been recently updated. 
The method is extended to open-web floor trusses for the first time. I-joists and 
open-web trusses are evaluated by the same method, allowing for consistent 
comparisons between the two. 
 
The analysis estimates the acceleration response of lower-frequency systems such as 
those characterized by longer spans or heavier subfloor/topping assemblies, systems 
more commonly encountered in open-web floor design. For I-joist designs that tend 
toward lower frequencies, the FloorChoice™ rating found in this version of RedSpec 
may be lower than the rating in previous versions. 
 

Composite Action for Red-I™ Joists 

Composite action accounts for increased floor member stiffness due to the permanent 
attachment of subfloor sheathing to the member top flange. The RedSpec™ composite 
analysis for open-web floor trusses is fairly robust, as it accounts for different 
thicknesses of sheathing and the method of attachment (glued and nailed, or nailed 
only). The Red-I™ joist analysis, on the other hand, has assumed the thickness and 
attachment, so the composite stiffness for floor members was sensitive only to 
spacing. This version expands the analysis of composite action for Red-I™ joists. Floor 
deflection of these members is now affected by the user’s selection of sheathing 
thickness and attachment. (Composite action is not included in the stiffness of roof 
members of any type, nor is it considered in the stiffness of beams.) 
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Hanger Database 

The hanger databases are updated to the latest available from Simpson Strong-Tie®, 
dated 2/6/2013. 
 

Interface Revisions 

1. Repetitive member increase/system factor: An increase in allowable stresses is 
allowed by the building code in some situations. RedSpec™ allows the increase 
for open-web truss designs at 24" spacing or less. RedSpec™ does not use the 
increase for truss designs at greater spacing, nor does it use the factor on any 
beam or I-joist design. Employment of the factor has not changed in this 
version of RedSpec™, but its use is now noted in the design output. 

2. Editing cells: This version allows the user to select a cell in the grids for 
additional loads (uniform, point, tapered) and select text or place the cursor 
for editing. Previously the user was allowed only to edit the entire contents of 
the cell. 

3. Maximum spans: The number of spans allowed is increased from four to five. 
4. Loading diagrams in “Display Load Cases”: Under the Options menu there is a 

command for showing shear and moment diagrams on design of beams and I-
joists. The load pattern associated with each load case is now depicted on the 
member diagram, which previously showed only the spans. 
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Bug Fixes 

1. The load diagram at the bottom of the Loads tab is updated even if the user 
does not Tab or Enter out of the span input on the Spans tab. 

2. Web stiffeners are sometimes required for Red-I™ joists in hangers, depending 
on load. If the typical hanger attachment to the joist is with the Strong-Grip 
hanger emboss, this is now replaced with 10dx1.5" nails since the Strong-Grip is 
not compatible with web stiffeners. 

3. The load diagram for net uplift loading no longer extends into other text above 
or below the diagram. 

4. Selecting an 18" or 20" depth of I-joist while leaving the joist series as “(Select 
All)” could result in an 18" or 20" Red-I45™ as a design option. As depths above 
16" are not available for this series, they have been removed from the 
database. 

5. In certain sequences of events in Canadian design, the CVC vibration analysis 
would appear in the results of roof joists. This is now prevented. 

6. The user was required to delete the existing value when editing negative or 
decimal values in load or slope cells. Now the user may begin the edit with a 
negative sign or decimal without having to delete the existing value first. 
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Release Notes (Archive) 
RedSpec™ 

 Version: 7.0.16 
 Release Date: August 30, 2012 
 Expiration Date: July 1, 2014 

 

Purpose of Release 

Version 7.0.16 is a maintenance release that includes the latest hanger databases. 
 

Description of Changes 

Hanger Databases 

The hanger databases are updated to the latest from Simpson Strong-Tie®. The US 
database has an adjusted installed-cost index (aka “ICost”) for stainless steel hangers 
such as the LIU. The higher index forces the stainless-steel hanger toward the bottom 
of the selection list when the list is sorted by installed cost. The Canadian database 
replaces the previous version, which has expired and no longer returns hangers in 
RedSpec when designing under NBC LSD. New ITS sizes are added to the Canadian 
database, as well as uplift capacities for optional installation and installation on 
nailers for top-flange hangers. 

Percentage Bars 

Graphics are added to the “Results” tab which illustrate the design-to-allowable ratio 
for each design control. Percentage bars are capped at 150% in the graphics. The bars 
are displayed for I-joist and beam designs. 

Bug Fixes 

1. On version 7.0.15 I-joist designs with holes where the shear at the hole was not 
the critical design control, the actual shear at the hole was erroneously output 
as zero in some cases. In this version the index that tracks critical hole shear is 
fixed to correctly display the hole location and actual shear at the hole in all 
cases. Note that the bug did not affect any designs where the critical shear at 
a hole exceeded the critical shear elsewhere in the joist, or in other words, 
where the “Shear @ Holes” percentage exceeded the “Shear” percentage. In 
such cases the correct shear and design percentage at the hole were reported. 
If the design percentage exceeded 100%, the design was correctly labeled as 
“overloaded.” 
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2. The picture box on the “Results” tab is taller to better accommodate all text 
and graphics. Previously the FloorChoice™ rating graphic could be truncated if 
the lines of text above were excessive. 

3. The text box that displays the open-web product to use is resized to fit within 
the print margins in cases where the text includes the lengthy feasibility 
message. 
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Release Notes (Archive) 
RedSpec™ 

 Version: 7.0.15 
 Release Date: May 9, 2012 
 Expiration Date: July 1, 2014 

 

Purpose of Release 

Version 7.0.15 is an external release of the numerous changes included in the release 
of 7.0.14, which was restricted to RedBuilt™ users. Please refer to the next three 
pages for a complete description of revisions that have occurred since 7.0.13, the 
last external release. 
 

Description of Changes 

Text Format Changes in Output 

Minor changes improve the consistency in format between the Results tab summary 
and the Print tab detailed output. 

Bug Fixes 

1. New hanger fastener codes 74 and 75 were not recognized. These are now 
translated to TTN25134H and TTN25234H, respectively. 

2. The RedLink.dll file installed via the 7.0.14 update was an older version, 
incompatible with the other changes in RedSpec™. The incompatibility 
prevented truss designs in 7.0.14. 
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Release Notes (Archive) 
RedSpec™ 

 Version: 7.0.14 
 Release Date: April 24, 2012 
 Expiration Date: July 1, 2012 

 

Purpose of Release 

Version 7.0.14 is an internal beta release for temporary use prior to the planned 
external release of 7.0.15. Changes are primarily bug fixes and minor new features. 
 

Description of Changes 

FloorChoice™ Parameters Added to Output 

The FloorChoice™ floor performance rating is affected by glued-and-nailed vs. nailed-
only sheathing, simple span vs. continuous spans, and rigid vs. flexible supports1. The 
selected parameters are now stated in the FloorChoice™ paragraph on the printout, in 
addition to the parameters of sheathing type, topping, ceiling, and blocking. 

Cut Length Assistance for Sloped Joists and Beams 

The horizontal projected length of a sloped member may be multiplied by the 
reciprocal of the cosine of the slope angle to obtain the sloped length. This factor is 
now provided in the notes on the printout, as well as the number of inches that must 
be added to account for a bevel cut. The note is displayed only for sloped I-joists and 
beams. When depth is an optimization variable, the bevel cut add is not shown. 

Required Bearing Length at Each Support 

The required bearing length for I-joist and beam members is given for each support on 
the printout. I-joist requirements are separated into “no stiffeners” and “stiffeners.” 
Previously the worst-case requirements for all supports were summarized in a note. 
The note is no longer used, unless the I-joist reaction capacity is exceeded. 

Net Uplift Reaction for Open-Web Trusses 

The net uplift reaction is shown in the results and printout for open-web trusses. In 
previous versions it was shown only if it was the critical load case. 

 
1 “Wall” and “Ledger” are rigid supports. “Beam” is a flexible support. 
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Hanger Database 

The hanger database is updated to the latest available from Simpson Strong-Tie®, 
dated 2/15/2012. 

Composite EI Update for Canadian Floor I-Joists 

Panel properties in accordance with CSA O86-09, Table 7.3C are used to derive 
composite stiffness of floor I-joists with glued sheathing under the NBC LSD code 
selection. Note that IF24 OSB sheathing is assumed. 

 

Bug Fixes 

1. Deflections were overstated on a joist design with replacement load and 
tapered load under NBC LSD. 

2. Vibration analysis was performed for all floor and roof I-joists under NBC LSD, 
although the results were not printed for roof joists. The vibration analysis is 
now bypassed on roof joists to speed processing. 

3. Certain designs with no positive moment would fail. For example, a design with 
a long overhang and additional loads on the overhang may have no positive 
moment under any load pattern. In this case the results would show an 
allowable moment of zero and a design percentage of 99999%. 

4. Truss designs that bear on the bottom chord would sometimes fail due to 
limited pin-to-end chord length at the bearing pin. To improve this, a vertical 
web at the bearing is now used whenever the truss slope is in the range 
of -0.5:12 to 0.5:12. It is not used on steeper slopes as this may lead to web-
angle geometry issues at the high end. 

5. The optimization process showed a preference for a double Red-I45™ when a 
single Red-I90™ of the same depth was cheaper. In this case, series and plies 
were the variables. 

6. Optimizing a member with three spans and two overhangs lead to a “not 
responding” error message. 

7. The I-joist optimization process would result in error messages (e.g., “a 
feasible option is not found,” division by zero, or overstress) when series was a 
variable and a 20" depth was selected. 

8. Sloped I-joists that failed in bearing would show a message box with the 
correct overstress percentage, but the percentage displayed in the printout 
was increased by the cosine of the slope. 

9. Hangers would not be found for certain sizes of sawn lumber because the joist 
type was incorrect in the hanger screen. 

10. Additional loads very near a support, other loads, or one end of the member 
could cause a “subscript out of range” loading error. 

11. A faulty product index prevented the finding of hangers for 3.5"x14" LVL, if the 
hanger style was set to “Any.” 
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12. The bearing of an open-web truss could be shown as “Top” on the printout, 
even though the user had chosen “Bottom.” This would occur if a top-bearing 
simple bearing was changed to a bottom-bearing overhang. 

13. When optimizing for open-web truss series, the results would show the assumed 
bearing width and bearing clip for the last series checked, rather than the 
optimum solution. 

14. Cost factors in the product database are updated to ensure the Red-I65™ is 
ranked lower (i.e., more economical) than the Red-I90™ when a design is 
optimized with variable series, and both series are viable options. 

15. Long load comments were allowed for input, but the design could not be saved 
unless the comments were shortened. Comment input is now limited as the 
user enters it. 

16. Wrapping of long file names on the printout forced a second page. 
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Release Notes (Archive) 
RedSpec™ 

 Version: 7.0.13 
 Release Date: August 26, 2011 
 Expiration Date: July 1, 2012 

 

Purpose of Release 

Version 7.0.13 incorporates Red-I™ joist properties in accordance with the recently-
reissued ESR-29942. There are no other changes. 
 

Description of Changes 

Red-I™ Joist Properties 

The revised ESR-2994 includes a number of changes to joist properties for the building 
code and methodology selection “IBC ASD.” Designs under “NBC LSD” are not 
affected. No other products are affected. The Red-I™ property changes may be 
summarized as follows: 

• Increased allowable shear for Red-I45™, Red-I65™, Red-I90™, and Red-I90H™. 

• Increased allowable reaction for certain depths of these series, where reaction 
values are controlled by shear. 

Changes to ESR-2994 Section 4.6, “Holes in Red-I Joist Web,” are aligned with the 
RedSpec™ allowable hole shear analysis. This does not represent a change in 
RedSpec™. 
 
New joist series and depths introduced in the latest ESR-2994 are not incorporated in 
RedSpec™ at this time. 

Addendum 5/8/12 

Consequent to a recent update in the embedded open-web truss analysis engine also 
used in RedOpenWeb™, the load factors for combinations 3 and 4 under IBC ASD are 
revised as follows: 

Previous: 

 
2 ICC-ES Evaluation Report ESR-2994, Red-I™ Prefabricated Wood I-Joists, reissued August 1, 2011. 
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Combination 3: 1.0 Dead + 1.0 Snow 
Combination 4: 1.0 Dead + 1.0 Roof 
 

Update: 

Combination 3: 1.0 Dead + 1.0 Floor + 1.0 Snow 
Combination 4: 1.0 Dead + 1.0 Floor + 1.0 Roof 
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Release Notes (Archive) 
RedSpec™ 
 Version: 7.0.12 
 Release Date: May 21, 2011 
 Expiration Date: July 1, 2012 

 

 

Purpose of Release 

The release of version 7.0.12 is coordinated with an update in the open-web truss 
price analysis. Other revisions are included to improve usability. 
 

 

Description of Changes 

Open-Web Relative Price 

When the user selects multiple truss series, depths, or spacings, RedSpec produces a 
list of candidate trusses ranked by relative price. The component costs in the analysis 
are updated in accordance with current RedBuilt pricing. 

Beam Properties 

• All available widths and depths of RedLam™ LVL are added for Canadian design, 
which previously was limited to 1.75" widths. Density of all RedLam LVL is 
changed from 40 to 42 pcf. (Note: Member weight is added to dead load on 
beam designs.) 

• Allowable shear of glulam beams available for US design is changed from 240 to 
265 psi in accordance with 2005 NDS. 

User Interface 

• Several graphical elements are revised and tooltips are added. 

• An indication of the direction of positive and negative slope appears on screen 
and printout. 

• The user is advised to exit RedSpec during the update process to prevent two 
instances of RedSpec running simultaneously. 

• VB6 runtime files are no longer distributed with updates and setups. 



  

RedBuilt™, RedSpec™, RedOpenWeb™, Red-I™, Red-I45™, Red-I45L™, Red-I58™, Red-I65™, Red-I65T™, Red-I90™, 
Red-I90H™, Red-I90HS™, Red-L™, Red-LT™, Red-W™, Red-S™, Red-M™, Red-H™, RedLam™, FloorChoice™ are 
trademarks of RedBuilt LLC, Boise ID, USA. Copyright © RedBuilt LLC. All rights reserved. 

 58 of 74 

Bug Fixes 

1. Graphical displays of simultaneous plf and psf loads do not appear in correct 
proportion for given tributary width.  

2. Graphical displays of point loads sometimes not shown unless design is closed 
and opened.  

3. Graphical displays of negative replacement load appear positive in certain 
conditions. 

4. “Ending location” error message appears after entering a point load in certain 
conditions. Design is allowed to proceed. 

5. “Sort failed” error message appears due to I-joist hole location. 
6. Adding a new folder to the project tree changes application loads to defaults 

on original design. 
7. Vibration and safe load analyses are not executed on alternative designs 

selected in the results grid. 
8. Snow(115%) and Roof(125%) loads are allowed in the same load combination. 
9. Depth-to-width ratio error triggered when switching member from deep I-joist 

or truss to beam. Design is allowed to proceed. 
10. Greatest depths in listbox disappear when width of beam is changed. User must 

reselect beam series to repopulate depth list. 
11. Can’t design 24f-V8 glulam or DF#2 sawn lumber. 24f-V4 and DF#1, 

respectively, are designed in lieu of them. 
12. Dead load reactions of a continuous beam design are overstated when 

concentrated load analysis is included. 
13. “Hole too wide” error message appears, but design is allowed. Design fails due 

to hole position issue, but it should not be allowed. 
14. “Holes too close” error message appears in certain circumstances when holes 

are an acceptable distance apart. 
15. I-joist optimization analysis results in an overstressed Red-I45 design when 

other valid designs are available. 
16. Plies control is disabled when a beam type is active in the project tree, then an 

I-joist type is selected in the tree. User must close and open design to proceed. 
17. Sheathing type is not set to default when switching building code from NBC to 

IBC. Control should remain visible so user can choose sheathing type under IBC. 
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Release Notes (Archive) 
RedSpec™ 

 Version: 7.0.11 
 Release Date: March 24, 2011 
 Expiration Date: July 1, 2012 

 

 

Purpose of Release 

Version 7.0.11 addresses a critical bug found soon after the release of 7.0.10. The bug 
causes a conservative error, but is deemed critical because it limits the capacity of 
certain open-web truss designs. See below for a more complete description. 
 
In addition, this version includes other bug fixes. 
 

 

Description of Changes 

Bug Fixes 

1. RedSpec uses a load duration factor of 100% instead of 115% in these 
conditions: 
 

a. RedSpec version: 7.0.10. 
b. Building code and methodology: IBC ASD. 
c. Member application: Roof. 
d. Member type: Open-web truss. 
e. Application loads: Snow roof (115%). 
f. Files: New and existing (i.e., all versions). 

 
The erroneously low duration factor may prevent the user from identifying the 
least expensive options of series, depth, and spacing. Also, a working design 
from a previous version may fail in 7.0.10. 
 
The bug does not affect Canadian designs, floor designs, roof (125%) designs, or 
any I-joist or beam design. 

2. The I-joist bearing control defaults to the lowest value (minimum bearing 
length, no web stiffeners) when the minimum and maximum values with web 
stiffeners are equal. This affects end bearings of the Red-I90HS™ less than 20" 
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deep, potentially failing the design erroneously, but only if the design reaction 
is in the range of 100.0% to 100.5% of the correct allowable. 

3. A “subscript out of range” error prevents the design of Canadian I-joists with 
holes. 

4. The selection of blocking rows is ignored in the computation of FloorChoice™ 
rating (version 7.0.10 only). 

5. Load locations very close to the left end of the member are moved when the 
file is re-opened due to a misreading of the scientific notation. For example, a 
point load at 1" from the left end (8.3333E-2 feet) is moved to 8.3333 feet, or 
8'-4". This affects load locations that are greater than zero but less than 1.2". 

6. When switching from IBC ASD to NBC LSD, and vice versa, application loads are 
not reliably translated. Note that the application load magnitudes frequently 
change when switching building code. This bug refers to the internal load ID. 

7. When changing application load type from “Snow roof (115%)” to “Snow roof 
(100%),” the “Save changes?” prompt is not triggered on closing, potentially 
resulting in loss of the change. These loads are only available under IBC ASD. 

8. During uninstallation, a dialog asks if the user wants to remove all files. The 
user’s response is ignored. Files are removed regardless of clicking “Yes” or 
“No.” 
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Release Notes (Archive) 
RedSpec™ 

 Version: 7.0.10 
 Release Date: March 16, 2011 
 Expiration Date: July 1, 2012 

 

 

Purpose of Release 

Version 7.0.10 is an unrestricted release of the updates first made available in version 
7.0.9, whose focus was the introduction of the National Building Code of Canada to 
RedSpec™. Please read the archived release notes in the following pages for a full 
description of changes. 
 
In addition, this version includes bug fixes and minor interface changes. 
 

 

Description of Changes 

Hanger Database 

The US hanger database has been updated to the latest available from Simpson 
Strong-Tie®, dated 3/1/2011. The changes that affect RedSpec™ are: 

• Previously, the program required web stiffeners on any I-joist 18 inches or 
taller, regardless of other criterion. That requirement has been removed.  

• Load limitations have been added to 3-1/2 inches and wider light-gauge 
hangers carrying an I-joist with no web stiffeners. 

• Loads have been updated per changes in the 2011 catalog. 

• Please note that all of the 2010 version DLLs will stop working on 12/31/2011. 
This will only affect RedSpec™ users who choose not to update prior to the end 
of this year. 

Printed Warning for Large Point Loads on I-Joist 

RedSpec™ displays an on-screen warning when an unfactored point load exceeding 
1500 lb is applied to an I-joist. The warning advises the user about the need for web 
stiffeners to support large point loads. This warning now appears on the Results tab 
after running the design, and it appears in the bulleted notes on the printout. The 
1500 lb criterion is used for all I-joist members regardless of the number of plies, 



  

RedBuilt™, RedSpec™, RedOpenWeb™, Red-I™, Red-I45™, Red-I45L™, Red-I58™, Red-I65™, Red-I65T™, Red-I90™, 
Red-I90H™, Red-I90HS™, Red-L™, Red-LT™, Red-W™, Red-S™, Red-M™, Red-H™, RedLam™, FloorChoice™ are 
trademarks of RedBuilt LLC, Boise ID, USA. Copyright © RedBuilt LLC. All rights reserved. 

 62 of 74 

since there is no assurance that a point load is evenly distributed to each ply of a 
built-up member. 

Bug Fixes 

1. In some conditions while switching from one building code to another, the 
depths available on the Design tab show only a single depth where there should 
be two (tapered) or three (pitched). The bug originated in version 7.0.9. 

2. A user reported an instance where a Red-I65™ joist is designed, even though a 
Red-I45™ is selected. 

3. A best-systems analysis of an I-joist design results in “no feasible option,” 
where a Red-I90HS™ solution should be offered. 
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Release Notes (Archive) 
RedSpec™ 

 Version: 7.0.9 
 Release Date: February 23, 2011 
 Expiration Date: July 1, 2012 

 

 

Purpose of Release 

Version 7.0.9 enables design according to the 2005 National Building Code (NBC) of 
Canada. The methodology is Limit States Design (LSD). Wood design is in accordance 
with CAN/CSA-O86-01 (reaffirmed 2006), “Engineered Design in Wood.” Red-I™ joists, 
RedLam™ LVL beams, RedBuilt™ open-web trusses, and two grades of glulam beams 
are available for design under the “NBC LSD” code selection. The audience for this 
release is restricted. 
 
A few maintenance items and bug fixes are also included in this version. 
 

 

Description of Changes 

Canadian Design 

In previous versions the only building code available was the International Building 
Code (IBC), using Allowable Stress Design (ASD). Implementation of NBC LSD entails a 
number of changes: 
 

• RedBuilt™ product properties: Properties such as shear and moment resistance 
and bending stiffness are taken directly from the CCMC Evaluation Reports for 
the respective products1. RedSpec™ operates with imperial units, so the CCMC 
properties are converted from SI to imperial units without rounding. Composite 
stiffness is calculated using sheathing properties tabulated in CAN/CSA-O862, 
thus deflection of composite members (i.e., those with glued and nailed 
sheathing) will vary between the two building codes. 

 
1 Evaluation Reports CCMC 13487-R, issued 2010-02-23, and CCMC 13485-R, issued 2010-02-16, National 

Research Council Canada. 
2 CAN/CSA-O86-01 (reaffirmed 2006), Engineering Design in Wood, Canadian Standards Association, pp. 68-69. 



  

RedBuilt™, RedSpec™, RedOpenWeb™, Red-I™, Red-I45™, Red-I45L™, Red-I58™, Red-I65™, Red-I65T™, Red-I90™, 
Red-I90H™, Red-I90HS™, Red-L™, Red-LT™, Red-W™, Red-S™, Red-M™, Red-H™, RedLam™, FloorChoice™ are 
trademarks of RedBuilt LLC, Boise ID, USA. Copyright © RedBuilt LLC. All rights reserved. 

 64 of 74 

• Application loads: Application loads may be selected according to the 
terminology provided in the NBC table of uniform live loads3. These are 
provided for convenience; the user may override any load. 

• Load combination factors for joists and beams: RedSpec™ does not 
incorporate the full gamut of load combination factors allowed in the code4. It 
is conservative to use a factor of 1.25 on dead load and a factor of 1.5 on all 
live loads (floor, snow, wind, quake), so these are the factors employed in 
RedSpec™. One exception is the case that includes only dead load. Here the 
factor is 1.4 on dead load. The user is responsible for reducing dead load in 
uplift conditions, as is the case under IBC ASD as well. An importance factor of 
1.0 is assumed for all loads. 

• Load combination factors for trusses: The open-web design engine fully 
implements the combination factors specified in the NBC. An importance factor 
of 1.0 is assumed for all loads. 

• Load duration factors: To facilitate application of load factors, the former 
numerical duration factors have been discarded in favor of text durations, 
affecting both building codes. The dropdown list on additional loads included 
durations of “100” and “115,” for example. These have been changed to 
“Floor,” “Snow,” “Roof,” “Wind,” and “Quake” where appropriate. Another 
change required by the NBC is the “permanent load factor,” which applies 
whenever dead load exceeds standard-term loads5. 

• Canadian Vibration Criteria (CVC) for floor joists and trusses: The criteria for 
evaluating floor vibration characteristics6 have been implemented, with several 
options for floor sheathing, topping, ceiling, and blocking. The RedBuilt™ floor 
performance measure, FloorChoice™, is simultaneously available for joist 
design. 

• Analysis: A second check on compressive resistance perpendicular to grain is 
specified in CAN/CSA-O86 for beams7. This is implemented with an increase of 
4/3 on required bearing length to account for assumed average bearing. The 
Canadian lateral stability factor and volume factor for beam design8 have been 

implemented. The shear load coefficient for large (volume ≥ 2.0 m2) glulam 
beam factored shear resistance9 has been included in a conservative form that 
assumes maximum shear throughout the length of the member. 

• Hangers: The hanger selection component toggles with the building code. 
Canadian hangers are selected based on factored loads. 

• User interface: The user may select building code on the Project tab. 
Additionally the user may set a default building code via the Options menu. 

 
3 National Building Code of Canada 2005, Volume 1, National Research Council Canada, Division B, pp. 4-8, 4-9. 
4 CAN/CSA-O86-01, p. 17. 
5 Ibid, p. 18. 
6 Concluding Report, Development of Design Procedures for Vibration Controlled Spans Using Engineered Wood 

Members, Canadian Wood Council et al, Sept. 4, 1997. 
7 CAN/CSA-O86-01, pp. 59, 170. 
8 Ibid, pp. 49-50. 
9 Ibid, p. 55. 
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This determines the building code of new files, but does not affect the code of 
existing files, so the user will be able to open and work with any file without 
affecting the saved choice of code. Products available on the Design tab are 
selected for the Canadian market. Printed output specifies whether the 
quantities are factored or unfactored, and includes evaluation of the CVC 
vibration check as a PASS/FAIL criterion. 

 

Compatibility 

Version 7.0.9 is backward-compatible. Any existing RedSpec™ file may be opened; it 
will appear with the building code set to “IBC ASD.” However, previous versions of 
RedSpec™ will not be able to open files that are saved in version 7.0.9. 
 

Bug Fixes 

1. Fixed the member copy procedure so that joist hole information is also copied 
to the new member. 

2. When a point load was applied directly over a support on a continuous floor 
joist with concentrated load (aka safe load), the analysis erroneously increased 
the shear and moment in the span to the right of the support, which could fail 
the design. This has been fixed. 

3. Fixed a bug that caused the member icon of beams or trusses to appear as a 
joist in some conditions when opening an existing file. This interface bug 
appeared only in the project tree and did not affect the analysis. 
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Release Notes (Archive) 
RedSpec™ 

 Version: 7.0.8 
 Release Date: December 9, 2010 
 Expiration Date: July 1, 2011 

 

 

Purpose of Release 

Version 7.0.8 addresses bugs that have been reported in the last release version, 
7.0.7, dated August 11, 2010. No new features are included in this release. A number 
of interface methods have been revised. 
 

 

Description of Changes 

First Use 

First-time users would start the software to a blank gray window after installation. 
This forced them to use the “New” command to begin their first design. This has been 
changed so that a Project1.red file appears. There is no “Save As” command for the 
user to change the name of the project, but this alternative may be better for first-
time users. After the first use, the last-used file is always opened (if available), as 
before. 
 

Default Sheathing for Floor Performance 

On new project files, the sheathing default was 20 oc span-rated sheathing (19/32", 
5/8"). This sheathing is thought to be used rarely, so the default was changed to 24 oc 
span-rated sheathing in order to yield a floor performance rating that is applicable in 
more systems. 
 

Concentrated Load 

When a design failed in deflection, the analysis did not continue with the 
concentrated load check. This was revised so the concentrated load check is carried 
out regardless of the status of any other control. 
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Uplift Reaction Warning 

The software previously failed a design when uplift exceeded 500 lb. A message would 
be displayed, but the output would say, “OVERLOADED” with no indication of why. 
This was revised to display a warning about the uplift reaction over 200 lb. The design 
does not fail based on uplift reaction. 
 

Hanger Selection Engine 

The latest hanger selection .dll has been included in the update. The file is dated 
8/16/10. 
 

Bug Fixes 

1. Removed rounding of span lengths that appear on diagram in load screen. Users 
may refer to the diagram as they input loads, so the rounding may lead them to 
input a load location that is slightly off the end of the span. 

2. Fixed saving of beam width input. Beam widths greater than the narrowest 
available width would default to the narrow width when the project file was 
opened. 

3. Fixed saving of hanger slope. If the user chose a slope that did not match the 
joist slope, the hanger slope would default to the joist slope when the project 
file was opened. 

4. Fixed a “division by zero” error due to an allowable of zero when no product is 
found. 

5. Fixed an error on the hanger screen. When a double nailer was chosen as the 
header, the header width was calculated to be twice the width of a single 
nailer when in fact it would be the same as the single nailer, since the nailers 
are stacked, not side by side. Header width affects the compatibility of top-
flange hangers. 

6. Fixed bug related to hole design. If the user designed a joist with a hole, then 
switched the member to a truss, it was possible to get hole design information 
on the truss by cancelling the warning messages. The fix removes holes from 
trusses and beams if the member is switched away from joist. 

7. Slight differences in span input vs. span lengths on the printout were fixed. 
Differences of a few hundredths of an inch were observed. 

8. Fixed run-time error that occurs when entering or pasting in a long folder name 
to the project tree. Input is now truncated to the string limit. 

9. Joists with two overhangs had a bug in the deflection output. Even if the right 
overhang was critical for deflection, the span ratio on the output was based on 
the length of the left overhang. Pass/fail and actual deflection in inches was 
correct, but the ratio was wrong. 

10. Fixed bug on mixing of roof load types. If the application load and an additional 
uniform load were entered as either snow or roof, but then switched from one 
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to the other, an error message would say that mixing of snow and roof loads 
was not allowed. This was fixed so the message appears only if load mixing 
actually occurs. 

11. A run-time error could occur if the last-used drive becomes unavailable, 
making the last-used file unavailable. The error is trapped so a program crash 
is prevented. 

12. A bug on beam depth could not be duplicated, but a safeguard was 
implemented. A user reported that the depth shown on the printout did not 
match the selected beam depth, although the design allowables did. The depth 
is now checked before the printout is displayed. If there is any discrepancy, a 
message asks the user to run the design again. 

13. A loading error could occur if a span was removed or shortened, causing a load 
to fall off the end of the member. Such loads are now removed or shortened as 
well to prevent the error. 

14. Allowable deflection in inches could vary by a couple thousandths of an inch. 
This was corrected. 

15. The member spacing for double or triple joists did not appear in the printout 
banner, as it did for single joists. The printout was revised to emphasize 
spacing. 

16. Joist spans were limited to 70', while truss spans were limited to 60'. This is the 
converse of proper span limits, and could lead to a run-time error if the joist 
design was attempted. This was fixed. 

17. Fixed the bug that caused the results to disappear when the save button was 
clicked. No data was lost, but the bug forced the user to design again. The bug 
only occurred on the first save. 

18. Spans less than two feet are not allowed for joists. The user is informed of span 
errors, but a bug allowed the user to design the joist anyway. This was fixed so 
that the span was set to minimum length automatically. 

19. Fixed a bug that allowed the floor performance rating to appear on roof joist 
designs. 

20. Added user warnings about approaching or exceeded kill date. The software 
does not function once the kill date is reached. Without these warnings, there 
was no indication of why the software would not start. 

21. Deflection controls were aligned with strength controls so that anything less 
than 100.5% passes. Previously deflections had to be less than or equal to 100%. 

22. Fixed a bug that displayed a 4' span as 3'-12.0" on the output. 
23. Fixed a bug that occurred when the user attempted to add a uniform load with 

negative live load and positive dead load that happened to sum to zero. A 
warning message would appear, but then the load would appear to be tapered. 
The revision resets the load to a uniform value. 

24. Fixed output for hole design. The comment string was overlapping the size and 
location string. 

25. Software was not allowing holes with spacing as allowed by the code report 
(two times the diameter or largest dimension). Spacing allowance was revised 
to match code. 
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26. The note about “geometric constraints” has been revised. The wording was 
changed to offer more detailed advice, and it now appears on output only if 
the truss design is otherwise feasible. Before it would appear on a failing 
design, which gave the impression that this was the reason it failed. 

27. Fixed startup issues due to Canadian date format. 
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Release Notes (Archive) 
RedSpec™ 

 Version: 7.0.7 
 Release Date: August 11, 2010 
 Expiration Date: July 1, 2011 

 

 

Purpose of Release 

This is the first unrestricted release of RedSpec™. 
 

 

Description of Changes 

“Save As…” Command 

The “Save As…” command has been removed from the File menu. The “Save As…” 
method was not typical: if the user closed the original file without saving changes, 
the changes were not included in the copied file, either. There was the risk that a 
typical user might save to a new file and unexpectedly lose current changes. 

Until the method is revised to behave in a typical way, the RedSpec™ user must use 
Windows® Explorer to copy a project file. 

 

 

 

 

 

 

 

 

 

 

 

 
Windows is a registered trademark of Microsoft Corporation in the United States. 
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Bug Fixes 

1. The user entered a decimal number in the member slope. The entry was lost 
when the file was closed and re-opened. 

2. When the user inadvertently entered a large tributary width (e.g., 27'), the 
program encountered a run-time error and quit. 

3. The user entered a 14.5" depth, but RedSpec™ designed a 14" truss. 
4. When the user changed from a tapered open-web to parallel and clicked the 

Design button, the program encountered a run-time error and quit. 
5. The user found no available hangers for the right end of a joist, although the 

left end had several choices in identical conditions. 
6. RedSpec™ returned a failed truss design, but later designed the same truss 

successfully. 
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Release Notes (Archive) 
RedSpec™ 

 Version: 7.0.5 
 Release Date: August 6, 2010 
 Expiration Date: July 1, 2011 

 

 

Description of Changes 

Concentrated Load 

The magnitude of the concentrated load used in the analysis of I-joists and 
rectangular sections has been revised. Previous versions considered the input value as 
distributed uniformly over a 2.5' square and converted it to a point load based on 
member spacing. For example, a 2000 lb concentrated load is 320 psf over the 2.5' 
square. At 16" o.c., the equivalent point load on the member would be 1067 lb. 

That method is quite conservative in that it ignores the load-sharing effects of 
sheathing. Particularly on closely spaced joists, the concentrated load will be 
distributed to adjacent joists to some degree. 

The revised method calculates the equivalent point load according to these rules: if 
the spacing is 24" or less, the input value is divided by two; if the spacing is greater 
than 24", the input value is used at full value. In the example above, the equivalent 
point load would be 1000 lb under the new method. 

Design shear at I-joist holes also has been revised according to these new rules. 

The placement of the point load in the analyzed load cases is not affected by this 
revision. The method of analyzing concentrated load in open-web design is also not 
affected. 

 

Lateral Support at I-Joist Bottom Flange 

RedSpec™ reduces the allowable moment of an I-joist based on the input lateral 
unbraced length found on the Spans tab. By trial-and-error, the user has been able to 
find the maximum allowable unbraced length on top and bottom flanges. 

The method had drawbacks when considering bottom-flange bracing. The extent of 
the bottom flange under compression is not calculated, so it is not possible to judge 
whether bracing is required, even when the maximum unbraced length is known. For 
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joists subject to net wind uplift, RedBuilt™ uses an independent calculation of 
unbraced length that is not incorporated into RedSpec™ at this time. 

Since uplift bracing and bracing of joists with overhangs is calculated independently, 
the lateral support control for the bottom flange of I-joists has been removed from 
the Spans tab. The allowable moment is not reduced by a stability factor when 
considering negative design moment. It is noted in the design results that “Lateral 
support at bottom edge shall be per RedBuilt recommendations.” 

The ability to control bottom lateral support of rectangular sections has not been 
changed. Lateral support for the bottom chord of open-web trusses continues to be 
per RedBuilt™ recommendations. 

 

PDF Save Folder 

RedSpec™ has been revised to default to the last folder used when saving a PDF 
output. 

 

Hanger Database 

The hanger database has been updated to the latest available from Simpson 
Strong-Tie®, dated 6/17/2010. 
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Bug Fixes 

1. Under the following conditions, RedSpec™ did not correctly calculate the 
required bearing length for hanger design on the right end of the member: 
 
- Member type: I-joist 
- Depth: 18" or less 
- No overhang on left end of joist 
- Hanger present on right end of joist 
- Reaction capacity is exceeded on the left end of the joist 
 
Hangers on the left end were not affected by this bug. 

2. When the user tried to optimize by I-joist series by clicking “(Select All),” 
RedSpec™ would try only the first series in the list, the Red-I45™. Users should 
now obtain results for other series of joists in cases where a heavier series is 
required. 

3. Users were only allowed to choose member slope from the dropdown list on the 
Spans tab. RedSpec™ has been revised to permit the user to key in any slope 
within the imposed limits. 


